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Steel Authority of India Limited 

 Rourkela Steel Plant 
Human Resource Development Centre 

Programme on “MMSS  AAcccceessss” 
 

 
 

Programme Schedule 
 

Day / 
Date 

Time  Topic 

Day-I 

 

 

 

 

8.30 am – 9.30 am Registration and Programme Briefing, Pre Test 

9.30 am – 1.00 pm General Concept of Database and Features in MS Access, 
Briefing and demonstration on different features of tables 
and their manipulation 

Exercise - I 

2.00 pm – 5.30 pm Searching, Sorting and Filtering Records 

Exercise - II 

Day-II 

 

8.30 am – 5.30 pm Learning Review, Briefing and Demonstration on Querying 
a Database 

Exercise - III 

Day-III 

 

8.30 am – 1.00 pm Learning Review, Briefing and Demonstration on Forms and 
their Manipulation 

Exercise - IV 

2.00 pm – 4.00 pm Briefing and Demonstration on Reports, Data Importing and 
Exporting to other Applications, Printing.  

Exercise - V 

4.00 pm – 5.30 pm Post Test, Feedback and Valediction 
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An Introduction to Database Development 
 
The fundamental concept underlying Access databases is that data is stored in tables. Tables are 
comprised of rows and columns of data, much like an Excel worksheet. Each table represents a single 
entity, such as a person or product. 
 
As you work with Access, you will spend considerable time designing and refining the tables in your 
Access Applications. Table design and implementation are two characteristics that distinguish database 
development from most other activities you may purse. 
 
After you understand the basic concepts and terminology, the next important lesson to learn is good 
database design. Without a good design, you constantly rework your tables, and you may not be able to 
extract the information you need from your database. Throughout this book, you learn how to use the 
basic components of Access applications, including queries, forms and reports. You also learn how to 
design and implement each of these objects.  
 
In Access, a database is the overall container for the data and associated objects. It is more than the 
collection of tables, however a database at the same time and simultaneously work with more than 
one database. Many Access databases contain hundreds, or even thousand, of tables, forms, quires, 
reports, macros, and modules.   
 
 

Table 
 
A table is just a container for raw information (called data), similar to a folder in a manual filing system 
(Fig.-1). Each table in an Access database contains information about a single entity, such as a person or 
product, and the data is organized into rows and columns. 
 
After you create a table, you view the table in spreadsheet-like forms, called a datasheet, comprising rows 
and columns; knows as records and fields respectively.  Fig.-1 shows the datasheet views of the 
Employee table.  

 
 

 
 

 
 

Table 

Record : A 
Collection 
of related 
fields 

Field : Space allocated to data items 

Fig.-1: Table, Records and Fields 
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In the Employee Table, you can note how the table is divided into horizontal (left-to–right) rows, and 
vertical (top-to-bottom) columns of data. Each row (or record) defines a single employee, while each 
columns (or field) represents one type of information about the employee. 
 
For instance, the marked row in Fig-1 contains data describing Employee Name-HM Patra, Pl. No., 
Designation and his Department. Each bit of information describing Mr. Patra is a field (Name, Pl. No., 
Designation and so on). Fields are combined to forms a record, and records are grouped to build the 
table. 
 
Each fields in an Access table include many properties that specify the specify the type of data contained 
within the field, and how Access should handle the fields data. These properties include the name of the 
fields (Name) and the type of data in the fields (Text). A fields may include other properties as well. For 
instance, the Size property tells Access how many characters to allow for a persons last name. (You learn 
much more about fields and fields properties in Chapter2.) 
 
Records and fields  
 
As Fig. - 1 shows, the datasheet is divided into rows (called records) and columns (called fields), with the 
first row (the heading on top of each column) containing the names of the fields in the database. Each 
row is a single record containing fields that are related to that record. In a manual system, the rows are 
individual forms (sheets of paper), and the fields are equivalent to the blank areas on a printed forms that 
you fill in. 
 
Values 
At the intersection of a row (record) and a column (field) is a value-the actual data element. For example, 
HM Patra, the name in the first record, represents one data value.  
 
Relational Databases 
Microsoft Access is relational database development system. Access data is stored in related tables, 
where data in one table (Employee) is related to data in another table (such as Trg. Attended). Access 
maintains the relationships between related tables, making it easy to extract a Training Module and all the 
employees attended that module without losing any data.  
 

 
 
 
 
 
 
 
 
Working with multiple tables 
 
Multiple tables simplify data entry and reporting by decreasing the input of redundant data. By defining 
two tables for an application that uses Employee table, for example, you do not need to store the 
Employee‟s name and other details every time in the Training Attended Table.  
 
Separated data into multiple tables within a database makes the system easier to maintain because all 
records of a give type are within the same table. By taking the time to segment data properly into 
multiple tables, you experience a significant reduction in design and work time. This process is known 
as normalization.  
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Knowing why you should create multiple tables 
 
The prospect of creating multiple tables always intimidates beginning database users. Most often, they 
want to create one huge table that contains all of the information they need. So, they create a single table 
containing a lot of fields, including fields for Employee Details (Name, Pl. No., Scale, Design, Deptt.)  
Training Attended (Training Code, Module Name), Address (Qr. No., City, State, Country, Contact No.) 
for each employee. Such a table quickly grows to an unmanageable number of fields and continues 
growing as new items are added.  
 
It is important to create tables that hold the minimum of information while still making the system easy to 
use and flexible enough to grow. To accomplish this, you need to consider making more than one table, 
with each table containing records with fields that are related only to the focus of that table. Then, after 
you create the tables, you link them so that you are able to glean useful information from them. Although 
this process sounds extremely complex, the actual implementation is relatively easy. Again, this process 
of creating multiple tables from a singles tables from a single table is known as normalization (or 
normalizing your tables). 
 
Access Database Objects and Views 
 
If you are new to database (or even if You are an experienced database user), you need to understand 
some key concepts before starting to build Access database. The Access database contains seven types of 
top-level objects(Fig.-2), which consist of the data and tools that you need to use Access. 
 

 
 
 Table  :   Holds the actual data 

 Query  :  Searches for, sorts, and retrieves specific data 

 Forms  :  Lets you enter display data in a customized format 

 Report :  Displays and print formatted data 

 Pages  :  Publishes data to a corporate intranet 

 Macros :  Automates tasks without programming 

 Modules :  Contains programs written in the Visual Basic for Applications (VBA)  

                               programming language 

Objects 
Fig-2: Access 
Database  Objects 
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Designing Your Database 
Before you touch the keys of the computer, you need to sit down with a scratch pad and pencil and 
choose a design and structure for your database. In the first place, you need to decide which fields to 
include in the database. How many distinct pieces of information does your database require? In the 
database, include fields for each type of information you conceivably might need some day. 
 
Creating your Database (extension is .mdb) 
         

Steps:  
1. Start MS Access by clicking the MS Access               icon on the shortcut bar 
 
 

2. Click the Blank Database option button in the 
Microsoft Access dialog box (fig-3) and then 
click OK. 

 
3. You will find the File New Database dialog 

box. Specify the folder in which you want to 
save the file and double-click on it, and then 
enter a name for the database in the File 
Name text box. Click Create when you have 
finished. 

 

Fig.-3: Blank Database 
 

 
Access opens the Database window with its seven buttons: Table, queries, Forms, Reports, Pages, 
Macros, and Modules (Fig-2). This is the starting point for creating the different parts of the database. It 
also opens a blank table, since tables are the fundamental building blocks of a database. 
 
Creating a Table 

 
Access offers three ways to create a database table. You can start in Design view and enter the field 
names yourself, create a table with Access‟s Table Wizard, or import the data from a table you 
already created.You start from the Database window,Click the Tables button and then the New buttons. 
You see the New Tables dialog box (Fig-4). 
 

This dialog box is where you decide how to 
create your table: 
 Datasheet View: Choose Datasheet View 

and click OK to view a blank datasheet in 
which you can begin entering data fields and 
table data. 

 Design View: Choose Design View and 
Click OK to design the table yourself.   

 

Fig.-4: New Table Dialog Box 
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 Table Wizard: Choose Table Wizard and click OK to get Access‟s help in designing and creating 
the table.  

 

 Import Table:  Choose Import Table and Click OK to import a table from another Access 
database; an Excel spreadsheet; a dBASE, FoxPro, or other database; or from a text file.  

 

 Link Table: You can also choose Link Table, which is a variation of Import Table. You don‟t 
bring the data into the database; you create a link, which allows the data to continue to be worked 
with and updated in the other application. 

 
Creating a Table in Design View  
 
Steps:  

1. Click on Table Tab of Access Window, then click New 

2. In the new table dialog bix, double-click on Design View  

3. Enter the Field Names, Data Type and Description as shown un Fig.-5 

 
 
 

 
 
 
 
 

 
 

 

 

 

 

 

 
 

4. Set Primary Key* for Pl. No field by moving the mouse pointer over Pl. No and then click on 

primary Key Icon            from  Tool Bar. 

 

* Primary Key 
 

A Primary Key Identifies one or more fields in a table that will hold unique data. No two records 
have the same entry in the primary key fields. Access will not allow it. In most database tables, 
one field should contain database table shown here, Employee Pl. No. is the primary key because, 
while two or more employees might have the same name or address, no two employees will have 
the same Personal Number. Primary key fields make it easier for Access to organize and identity 
records in database. When you create a database table, Access asks you to specify the primary key. 
Another advantage of a Primary Key is that it speeds up data search in a large table. 

 

 

Fig-5: Table in 
 Design View 

 

Primary 
Key 
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5. Click on the Save Button in the Standard tool Bar. You are prompted for a name for the table. 
6. Enter File Name „Employee‟ and click on the OK button. 

7. Click on the Datasheet View icon             on the standard toolbar. 

8. Enter data 

9. Close the Datasheet view of the table by clicking on the Close           button. 

 

Design View vs. Datasheet View 

Design view is used to change the structure of 

the table, such as the fieldnames or data types, 

or to change field and table properties. 

Datasheet view is  used for entering data, 

modifying it, deleting it; in short; this view is 

used for manipulating the data 

 

The Data Types 

When you create a field, Access asks you to choose a data type. Following are explanations of the 
ten data types: 
 

Data Types Description 

Text For   storing text (name, for example), combinations of text and numbers 
(street addresses), and numbers that aren‟t meant to be calculated (Social 
Security numbers and telephone numbers). A text field cannot be longer 
than 255 characters. 

Memo Stores data that exceeds 255 characters. Choose this data type when you 
want to include Long descriptions in a database table. For really long 
chunks of text (say, a page or more) use the OLE object data type instead. 

Number  For storing numbers that are to be used in calculations. 

Data / time For storing dates and times. (To choose how the date or time is formatted, 
click the Format box in the lower half of the Design View dialog box and 
choose a format from the drop-down menu.) 
 

Currency  For storing monetary figures that are to be used in calculations 

AutoNumber For entering numbers in sequence each time you add a new record to the 
table. For example, the first records is 1; the second, 2; and so on. Each 
number can only be used once in the field. By choosing the AutoNumber 
data type, you make sure that the data in the field is unique and is not 
repeated. Use the AutoNumber data type for the primary key field if no 
other field in the table stores unique, one-of-a kind numbers such as Pl. 
No.. To make the AutoNumber Field assign random numbers instead of 
sequential numbers, click in the New values box on the lower half of the 
Design View dialog box and Choose Random from the drop-down menu 
instead of Increment. 
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Yes/No  For storing logical or Boolean values  such as Yes/No, True/False, Checked 
Out?,Beautiful/Ugly. When you choose this data type, a box appears in the 
field. Checking the box means Yes, True, Checked Out, Beautiful, and so on; 
an Empty check box means No, False, Not Checked Out, Ugly; and so on. 

OLE Object For storing text, spreadsheets, photograph of Employees, sounds, and other 
data created in Word, Excel, or other programs. The Memo data entry type is 
fine for Entering a paragraph or two; but if you want a page or more to appear 
in a Database table, you are better off choosing the OLE Object data type. 

Hyperlink Used to stroe URLs, e-mail address or links to other files on the system.  

Lookup Wizard For retrieving values either from another database table or from a list of 
Values in a Combo box. When you choose this data type, the Lookup 
Wizard comes onscreen so you can designate which table to get the data 
From or enter the values that will appear in the combo box. See 
“Creating a Data-Entry drop-Down List,” later in this chapter, for more 
information. 

 
 Establishing Field Properties for Easier Data Entry 
 
As shown in Fig.-5, the lower half of the design view window offers boxes for choosing properties for 
fields. Properties make data entry easier. They also help make entries more accurate, make searches go 
faster, and make sorting faster. The field size property, for example, determines how many characters can 
be entered in a field. If you will set it to 2, it will not allow for data more than two characters.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CAUTION : Before you choose properties for a field, make sure that the cursor is in the correct 

field in the top half of the window in Design View. Property settings apply to whatever field the 
cursor is in. 

 

TIP:  

 

 

Fig.-6: Field Properties 

For detailed information about a property, 
click in its property box and then press F1 
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A brief description of some the common field properties are provided below: 
 

Field Size: Determines how many numbers or characters at maximum can be entered in the field. Use 
the field size property to make data entry more accurate. If the field stores phone number, for example, 
and you know that no phone number can be longer than 14 characters, enter 14 in the field Size box.  
 

Format: This property is for determining the format in which dates, times, numbers, currency figures are 
displayed. For example, if date is to be displayed in 12-Jun-2008 format, then “dd–mmm- yyyy” 
properties is to be used. You can also format text. To do so, enter one of the following characters in the 
format box: 
 

Character Description 

@ Tells that a text character or a blank space is required in the field. 

& Tells that a text character is not required in the field  

< Requires all characters in the field to be lowercase 

> Requires all characters in the field to be uppercase 

 

Input Mask: This property is used to control the values that can be entered by a user in a field. It lays 
down blank spaces and punctuation in the field so that numbers and letters can be entered accurately. The 
following illustration shows an input mask for entering a telephone number.  
 

Telephone 
(0661) 264-5050 
(0661) 264-9281 
(0661) 264-8659 
(____) ___-____ 

 
 Suppose the input mask “(0661)”000;0;* were to be entered in the „‟Input Mask‟‟ property for the Phone 
Field. We would be able to enter only numbers such as (0661) 264, (0661) 367, (0661) 526,  etc. Note that 
the „‟Input Mask‟‟ has three parts, which are separated by semicolons, of which only the first part (the 
„mask‟ itself) is mandatory.  

 

Input Mask explained:    “(0661)”000    ;            ;     0 * 

The Mask Itself: The inverted 
commas around (0661) ensure 
that (0661) is displayed in every 
members code as constant. 
(0661) are also referred to as 
„‟literal‟‟ characters. The three 
zeros indicate that the user is 
expected to enter 3 numbers 
compulsorily. 

 

The Place Holder character: The character 
entered here is displayed in the fiield (in 
datasheet view). It indicates the number 
of letters or numberes to be entered in 
the field  

Save Literals?: „0‟ if the „literal‟ characters 
are to be stored, and „1‟if they are not to be 
stored. If this part is left empty, it is taken 
by default to be „1‟.  
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Caption: A meaningful alternative name can be assigned to a field by entering a value in the caption 
property. The word or words you enter will be appear in datasheet view, on reports, and on forms in 
place of original field name. 
 
Default Value: The default value property enters a value in each new record so you don‟t have to enter it 
yourself. It can be a word, abbreviation, or number. You can always delete the default value and enter a 
different value.  
 

Validation rule: the validation rule lets you set down rules that have to be followed in order for data to 
be entered in the field. To create a validation rule, you enter an expression in the Validation Rule box. For 
example, the expression Ís Not Null‟ tells access not to allow an empty or null entry in the field. Or, if 
you wanted to exclude negative amounts in the field, you might use the expression ‟>0‟. 
 

Validation Text: if you established a validation rule for a field and someone enters data that breaks the 
rule, Access displays an error message. You can however, write an error message of your own by 
entering it in the Validation Text text box. This error message, for example, warns a data-entry 
employee that they have to enter a value for the field: 
 
 
             
             
             
              
 
 
 
Required: This property can be set either „Yes‟ or „No‟. when set to „Yes‟, the user must compulsorily 
enter values in that particular field, otherwise an error message will be displayed. By default, it is set to 
„Yes‟. 
 

Moving, Copying, Deleting, and Renaming Fields    
 
After you have gone to the trouble creating all the fields for the database table, you might discover to your 
dismay that fields are in the wrong order, that some fields don‟t belong in the table, or that some fields 
need new names. The following pages explain how to move, delete, and rename fields. 
 

Moving and Copying Fields 
Move a field when you want it to appear in a different place in the table. To move a field, follow these 
steps: 

1. Select the field by clicking on the box to its left. The field is highlighted. 
2. Drag the field up or down across the small squares to the left of the fields. As you drag, a gray line 

appears between fields to show where the field will land when you release the mouse button. 
3. Release the mouse button. 

 
Copy a field when all its setting-its data type and field properties-can be used over again in another field. 
After you have copied the field, be sure to rename it. Identical fields cannot appear in the same table. To 
copy a field, follow these steps: 
 

1. Select the field to be copied by clicking the box to its left in Design view. 
2. Press CTRL-C or right click and choose Copy from the shortcut menu. 

! Microsoft Access                                

You must enter a value for this field. 
 More Help 

 
 OK 

 

Fig.-: 7: Error Message 
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3. Click on the field that you want the copy to appear above.  
4. Either press CTRL-V or right-click and choose Paste on the shortcut menu. 
5. Change the field name for the field you copied. 

 
Renaming a Field 
Steps:  

1. In Design view click in the box where the field‟s name is 
2. Delete the name that is there, and enter a new name.  

 
It doesn‟t matter if the field whose name you change in linked to a field in another table, because changing 
the name of a field doesn‟t affect the relationships between tables. 
 
 
Deleting a Field 
 
Think twice before you delete a field. After you delete it, all the data contained in that field is lost 
from every record in the database table. You can‟t recover it.  
 
Steps: 

1. In Design view, select the field you want to delete by clicking the little box to its left. The field is 
highlighted. 

2. Either click the Delete Rows button or right-click and choose Delete Rows. 
3. When Access asks if you really want to go through with it, click Yes. 



Page 12 of 37 

 

 
 

 
1. Create a database named MASTER    
2. Create the following tables using Design View with specified fields: 

                Employee        Trg_Attend                                  Trg_Code 
Field name Type  Pl. No Number   Trg_Code Number(Primary Key) 
Name Text  Trg_Code Number  Description Text 
Pl. No Number (Primary Key)       
Design Text       
Deptt. Text       
Scale Text       
Basic Number       
DA Number       

            
3. Enter the Data as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. . Insert Telephone_ No field to Employee Table 

5. Set the field properties of Telephone_ No  field with the help of Input Mask so that numbers and letters 

can be entered accurately in the following manner: 

Telephone 

(0661) 264-5050 

(0661) 264-9281 

(0661) 264-8659 

(____) ___-____ 

 

6. In the Trg_code table ensure that the Trg_code field should never be below „0. Also provide an 

appropriate message that will be displayed in case the user enters an invalid value 

7. In the Trg_attend Table, ensure that data must be entered for the Trg_code field. 

Exercise-I 
 

EMPLOYEE 

name plno design scale deptt Basic DA 

CHAUHAN PC  37019 DY. MGR.  E3A SMS-II  18250 7280 

MUNDARI S  37024 TECH. S06 PM 6890 2820 

MOHANTY S B  37027 SR.MGR.  E05 T & RM  25000 12800 

SRIVASTAVA A K  37028 ASST. MGR.  E2F SSM  12000 6290 

KULLU C  37031 DY. MGR. E3A HSM  18600 7300 

KHAKHA B  37032 DY. MGR. E3A HSM  18600 7300 

BHUMIJ N C  37034 SR OPTV.  S07 ERWPP  9870 3500 

MAHANTA T K  37035 SR OPTV./SR.TECHN  S10 SP-II  9870 3500 

SAHOO SANKAR  37036 CHARGEMAN  S09 RC (M)  13250 6200 

DAS P K  37037 MASTE OPTV . S10 SSM  11760 6000 

SINGH P C  37041 SR TECH.  S10 SSM  10280 5790 

PATRA H M  37042 SR OPTV.  S07 ERWPP  9820 3460 

 

Trg_attend 
plno Trg_CODE 

37024 30309 

37024 30310 

37036 30310 

37041 30310 

37024 30310 

37037 30311 

37037 30312 

37027 32601 

37019 32602 

37031 32602 

37032 32602 

37028 32603 

37035 32604 

37042 32604 

37024 32604 

 

trg_code 

Trg_code Description 

30309 MS WORD 

30310 MS EXCEL 

30312 MS ACCESS 

32601 EME 

32602 MDP-II 

32603 MDP-I 

32604 SDP 
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Searching, Sorting and Filtering Records 
 
Searching: 
To search for example a Pl. No, the Find and Replace Dialog box can be used. 
Steps: 

1. Open the table in datasheet view 
2. Click on the Find Icon on the toolbar 
3.  This displays the box shown (Fig.-8) 
4. Enter the Pl. No. in the Find What Box 
5. Then press find Next Button  

 
 
 
 
 
          

 
 
 
 
 
 
 
 
Sorting: Very often records need to be sorted in some order. To do this follow the following 

steps: 
Steps: 

1. Open the table in datasheet view 
2. Select the field to be sorted 
3.  Click on the          (for ascending order) or               (for descending order) on the standard toolbar. 

 
 
 
 
 
 
Filtering: 
Besides the need for sorting, sometimes you may need to see all the records for a particular department. In 
such a case, records meeting the necessary criteria have to be displayed. This is known as 
„Filtering‟. 
 
Filtering in Access can be done in two ways: Filtering by Selection and Filtering by Form. The figure 
(fig-9) below displays the tools that help create the two types of filters. The third button is used to „Run‟ 
the filter.  

   
Filter by Selection Filter by Form Apply filter 

 

 

 

Fig.-: 9:  The 
‘Filtering’ tools 

980256 

Note: when the records are sorted or ordered, an entire record ( not just the selected field) is 
treated as a single unit, and is sorted. 
 

Note:  
 The searching can be narrowed to a particular field by clicking in that particular field and selecting 

the field in the „Look In‟ box. 
 

 The „Match Box‟ is used to narrow the search by specifying whether the search should be done to 
find the exact match of the entire word or only a few characters should be compared. 

 



Page 14 of 37 

 

Filter by Selection: 
Steps: 

1.   Open the table in datasheet view 

2.   Place the cursor in any of the cells in deptt. field for example in ERWPP 

3.   Press „Filter by Selection‟ button. This will display only the records where the deptt. is 

„ERWPP‟. The other records are temporarily hidden. 

 

 

 

Filter by Form: 
Steps: 

1.   Open the Employee Table in datasheet view 

2.   Place the cursor anywhere in the deptt. field  

3.   Press „Filter by Selection‟ button. The result will be  shown in the figure-10 below: 

4. Click on the down arrow in the “Deptt” 
field and select „ERWPP‟. This will 
display the records where Deptt. Is 
ERWPP. 

5. Click on the Or Tab and give deptt. Option 
HSM 

 
6. Click on the Apply Filter button again to 

display all records for ERWPP and HSM.  
Fig.-10: Filter by Form 

 

 

 
 
 
 
1. In the Trg_Attend Table replace all the Trg_code to 30309 with 30399.   

2. Set all the Trg_codes (30399)  back to 30309 

3. View the records of Employee Table in the Order of Basic 

4. Using Filter by Selection, display all the records in of Trg_attend for Trg_code 30310 

5. Display all the records in trg_attend table for Trg_code either 30309 or 30310 using Filter by Form 

 

Note: Here you can notice that the ‘Apply Filer Button’  appears pressed. To make all the records 
appear once again, click on ‘Apply Filter’ button. 
 

Exercise-II 
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Queries and Relationships 
 
Relationship in Microsoft Access 
 
Retrieving records from a single table is easy enough. But to access records from more than one table, we 
need to set relationships. Once the relationships are set, the user can access the required fields from 
different table with the help of „Query‟.  
 
In the previous chapter, you might have noted that the personal numbers that existed in Employee Table 
were entered in Training Attended Table. The reason for this will get clearer as we proceed further. 
 
 As seen in Fig. -11 below, every Pl. No in Attended Table has to have an entry in Employee table. In 
both the tables, the Pl. No. field is common, and it is that field helps us to establish an association 
between the two tables. Such an association is called a „Relation‟. 
 
  Attended Table                        Employee Table         

 
 

 
Fig. -11: Relation Between Tables 

 
Once such a relationship is established, relevant data from the two tables can be obtained by matching 
data with the help of the common field. The table below can be obtained by matching data with the help 
of common field. 

 
Fig.-12: Accessing fields from ‘Employee’ and ‘Attended Table’ 

 

 
Thus, a relationship can be defined as an association between common fields in two tables, 
which helps us put together information from different table. 
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Data is stored in the table as shown in fig.-12(previous page). However you may wish to view the data as 
follows: 
 Only some fields at a time 

 Only some records at a time 

 With calculated fields 

 Arranged in order of any one of the fields 

 
So, requesting specific information from one or many tables is called „Querying‟. In other words a „Query‟ 
is a „request‟ for information from a database. 
 
Familiarity with the Query Environment in Access 
 
Before we proceed further, we need to be familiar with the „Query ‟environment in Access. Like all the 
objects in database, the queries have also two views. 
 

1. Design View  :  used to create the query 
2. Datasheet View  :  used to display the results.  

 
Design View 
 
 The Design View (fig-13) has two parts. The upper part displays the table or tables which contain the 
required fields. The lower portion of the window is a grid, which usually has 6 rows (the no. of rows 
may increase or decrease). 
 
 

 
  
  
      Upper Part 
        (Tables) 
 
 
 
 
      Lower Part 
        (Grids) 
 
 

Fig.-13: design view of the Query 
 
An explanation of each of the rows is given below: 
 

Field :  as the names of the fields that are to be included in the query. 

Table   : Displays the names of the table to which the corresponding field belongs 

Sort :  Is used for setting the sorting order (ascending, descending or neither) for any of the rows. 

Show      : Contains a small check box. When this check box is ticked, that particular field is to be shown. 

If   the check box is empty, the field is hidden in the datasheet view. 
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Criteria   : Contains criteria, based on which the records will be selected.  

 
 
 
 
 
 
 

 
Creating a Query in Design View: Let us suppose that the in-charge of the SSM wants to know the list of 
employees along with training attended for a given module say: MS Word. For this proceed as follows: 

 
Steps: 
1. Open the database 
2. Click on the Query Tab and then click  „Create 

Query in  Design View‟ and press OK (fig.-14)  
3. The show table box is displayed in the foreground with 

the query‟s design view in the back ground as shown 
in fig-15 below. Select the tables to include in your 
query and click Add 

4. Double click  or Drag and drop the required field(s) 
form the table (s)  to the field grid(fig-16). 

5. Click the save button and give a name to the query 
6. To view result, click the data sheet             button on 

the stand Toolbar  
 

 

                 

 
 

 

 
Entering the Query Criteria: 
 
Include Criteria on the line of the Query Grid (Fig.-16) when you want to query for certain kinds of 
records. Unless you enter the criteria correctly, Access can‟t query a data base. In fact, if you enter criteria 
incorrectly, the programme shows you a message window with a cryptic explanation of why your criteria 
are wrong. For example, to query the records of people who have attended MS Excel (Tg. Code: 30310), 
the query grid looks like this:   
 

Note: When multiple criteria has to be set, and records need to be selected provided both the criteria 
are met, the criteria are written in the same row (AND Gate Condition), under the appropriate fields. 
However when the multiple criteria have to be set such that either one or the other criterion has to be 
met, one criterion is written in the ‘Criteria’ row, and the other written in the ‘Or’ row(OR Gate 
condition).   
 

Fig.-15Show Table Dialog Box  
 

Fig.-16 
 

Fig.-14: Query Design 
Window 
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Besides querying for records that meet criteria in different fields, you can require records to meet more 
than one criteria in the same field. Consider the criteria in the following illustration. This query not only 
seeks the records of employees who have attended MS Excel, also it will restrict the seek for only „Plate 
Mill, RC (M) and SSM‟. 
 

 
              
 
Guide Lines for Entering Criteria on the Query Grid 
 
Following are guidelines for entering criteria on the query grid: 
 

 Quote Marks(“) and Pound Sign (#): Access puts quotation marks around text criteria and pound 
signs around the date criteria. However, you do not need to enter those symbols yourself. The 
programme enters them for you after you move the cursor out of the criteria box. 

 

 Number formats : Do not enter commas when you enter numbers on the query grid. For example, 
to enter the number 45,000 you need only enter 45000. If you include a comma in number or 
currency figures, access flashes a message that says you created the expression incorrectly. 

 

 Date Formats : You can enter dates in all three of access date formats. For example, to find records 
dated December 31 , 1978, you can enter the date in the query grid in any of the following ways; 
12/31/78 , 31-dec-78, or December 31, 1978. 

 

 Operator Names: It doesn‟t matter whether you enter operator names such as Not and Between in 
all uppercase or all lowercase letters. Access capitalizes the first letter and lowercases the other 
letters for you. 

 
 
Text Criteria 
Text criteria are the simplest and easiest type of criteria. To enter text criteria, all you do is enter letters on 
the query grid. 
 
Two operators, Not and Like, can come in handy when you are working with text criteria. The Not 
operator tells Access to exclude a criterion from the search. By using the Like operator along with 
the  asterisk wildcard, you can search for groups of records. Some examples are given below: 
 

30310 

Fig.-17: Query with criteria 
 

Fig.-18: Query with 
multiple criteria in the 
same field (marked 1) 

 

 

1 2 
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 If you enter Like F*  in a query grid, it will find all the records, whose names begin with the letter 
”F”. 

 Entering Like[A-E]* finds the records, whose names begin with the letters “A”, “B”,”C”, “D”, 
and “E”. 

 Entering Like *Ltd. Finds the records, whose name end with the “Ltd”. Suffix. 
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Numeric Criteria 
Use numeric criteria in Number and Currency fields to find specific kinds of records. The table given 
below lists the operators you can use in Numeric and Currency fields. 
 

Operators Name Example (in a Basic 
Field) 

Query Results 

= Equal to =6500 Basic exactly Rs.6500 

<>/Not Not equal to <>6500 Basic not Rs.6500 
< Less than <6500 Basic less than Rs.6500 

<= Less than or equal to <=6500 Basic Rs.6500 or less 
> Greater than >6500 Basic  more than Rs.6500  

>= Greater than or equal to >=6500 Basic Rs.6500 or more 
Between
….And…. 

Between Between 6500 And 7500 Basic between Rs.6500 and 
Rs.7500 

 
Date Criteria  
 
All the numeric operators that  can be used in numeric fields on a query grid can also be used in date 
fields. For example, entering <3/8/97 in a field finds all records that were made before (or less than)                
March 8, 1997. 
 
 
 
 

            

Performing Calculations on Query 
 

By performing calculation query, you can make a query results table work like a spreadsheet. For 
example, you can find out, how much will be DA of each employee, if the DA will be increased by 2 
percent.  
 

Steps:  
1. Open the Query in design view 
2. Drag the fields you want to display in datasheet view 
3. Click in the last column in the „Field‟ (marked 1 in the fig. 19) and type New 

DA:[Employee]![DA]*1.02  
4. Press enter. Run the Query 
5. In the similar process, you can enter expressions to other fields 

 

 
 

Note : Access offers a function called Date() that represents today’s date and can be useful in date 
expressions. 

 

Fig.-19: Query displaying a calculated field  
 

1 
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The expression we have written is explained below: 
 

New DA:[Employee]![DA]*1.02  
 

„New DA‟ is the name we would like the new field have. (Ensure that a colon(:) follows it). If the name 
is left out, in data sheet view, the calculated field is given the name „Expr1‟. The rest of the expression 
can be explained as the „DA‟ field from „Employee‟ table multiplied by 1.02. (Ensure that an 
exclamation mark (!) separated the table name from field name) 

 
Summery: Getting comprehensive Information About Data in a Field 
 
A summery can find the Sum, Average, Lowest or Highest value, Number of, Standard Deviation, 
Variance, or First or Last value in a field. Only Numeric Data can be summarized. Access offers a menu 
with functions for summarizing the data in a field. The table given below explains the different functions 
and their use: 
 

Function What it Does 

Sum  Totals the values in the field 

Avg  Finds the average value in the field  

Min  Finds the lowest value in the field  

Max  Finds the highest value in the field  

Count  Counts the number of values in the field  

StDev  Find the standard deviation of the values in the field 

Var Finds the variance of the values in the field 

First Finds the first value in the field 

Last Finds the last value in the field 

 
Follow these steps to create a query that summarizes data in a query results table: 
 
1. Create a new query, choose which tables to query, and choose which fields to query 
2. Choose View ->Totals or click the Totals button              on the Query Design toolbar. A Total 

        row and the words „Group By‟ appear on the query field. (Fig.-20 a) 

3. Click on the Total row of the field you want to summarize 
4. Open the drop-down menu on the Total row and choose the function from the drop down menu. 
5. Run  the Query to see result 

 

This Summery Query will group all 
the Employee deptt. wise and will 
give the no. of employees(Count) of 
the departments as follows: (Fig 20 b) 

    Fig-20( b) Fig.-20 (a ): Query with data summary  
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Create the following Queries in Design View and Display the data in datasheet View: 

1. Q_attend: with Employee name, Deptt, Design from Employee Table, Trg_Code from 

Trg_Attend Table and Description from Trg_Code Table. 

Note:  (Trg_code need not be displayed)  

2. In the above query display only the records for Trg_code 32601 

3. Modify the criteria to display records for: 

 either Trg_code 30310 or 30312 

 for Trg_codes begins with 303 

 for Trg_codes 32604 and deptt. SP-II 

 deptt. Either "PM" Or "RC (M)" Or "SSM" and trg_code 30310 

 deptt. names begin with letters P”, “Q”, “R”, “S”,  and “T”  

4. Create a new query Displaying the name, Design., Deptt for Basic between 12000 to 25000. 

5. Modify the above query to Display Total Basic for Deptt. HSM with calculation Query. 

6. With Calculation query, find out, how much will be the new DA for each employee, if the DA will 

be increased by 5 percent.  

7. Prepare a summery of deptt. wise  employee list (hints: Use Count option for Pl. No.) 

Exercise-III 
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Action Queries: While a select query only selects records or fields from tables, „Action‟ queries 
modify the table and its contents. There are four „Action‟ queries in Access. They are: 
 

 Delete Query  :   used to delete unwanted records 
 Append Query  :   append (Add - at -End) some records from Table 1 to Table 2 provided 

                                              the design view of both the tables are same 
 Make table query  :   creates another new table from a query based on some criteria 
 Update query   :   updates the value of a field to a new value 

 
Delete Query: Suppose you want to delete all the Records of attended Table for Trg_Code 30310, 
follow the steps: 
1. Create a new Query in Design View  
2. Give the criteria for Trg_code field(30310) 
3. Click the Query Type Button(Fig.- 21) and 

Select Delete Query 
4. The title of the Window now will change to 

Delete Query from existing Select Query 
5. Click the Run Button  
6. A prompt appears to inform you that some 

records will be deleted. Click on the „Yes‟ 
button 

7. Open the Trg_attended table  and you can 
find the records for code 30310 are no more 
in the Table.  

8. In the similar process you can create the 
other Action Queries. 

 
 

Fig.-21 

 
 
 
 
 
 
CAUTION : Create a copy of database MASTER and design the following Action Queries: 

1. Delete all the records from Trg_attend table for Trg_code 30309 using Delete Query 

2. Using Append Query add the records from Employee Table to Employee _copy for deptt SSM 

3. Find out the records from Trg_attend Table for ERWPP and store it in ERWPP_attend  table using 

Make Table Query 

4. Using Update Query Replace the Old Basic to New Basic as  Baisc+DA 

 

Exercise-IV 
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Forms: A „Form‟ is a document containing blank fields into which a user enters data. Access forms are 
very much like the forms you fill out to apply for a job or a driver‟s license.Although a Table or Query‟s 
datasheet view can be used to do the same data entry, a form presents the data in an organized and 
attractive manner. Access forms create the user interface to the tables. The forms are designed from a 
collection of design elements called „controls‟.  
 
Things that can be done in a database application using forms are: 

 Manipulate data in the Tables 
 Run Queries 
 Print Reports 

 
Thus, a form is essentially the binding element of an application. 
 
A form consists of the following: 

 User-interface components 
 Instructions 

The most common example of a user interface component is a button, such as the one shown below: 
 

 
Associated with the button is an instruction that displays the next record from the table in the form. Thus, 
clicking on this button will display the next record in the table.  
 
Common User Interface Components 
The user interface consists of several different components, which we referred to as „controls‟ that are put 
together as required. These controls have to be placed in some sort of container. In access this „container‟ 
is a „Form‟(Fig.-22) 
 

 
 Fig.-22 : Access Form with Common Controls 

 
Button 
A button is used to perform an action. A user clicks on a button to indicate the action is to be 
performed. For example, the user clicks on the Save Record button to indicate that the details 
entered in the form should be saved as a record. A button can have text or a picture on it as shown 
in the above figure. 



Page 25 of 37 

 

Text box 
A text box is a user interface component used to accept information from the user. It is also called 
an input box. Typically, an interface will use one text box per piece of information required from 
the user. 
 
Label 
A label is a component used to place text in a form. Typically, a label is used to identify 
components like a text box. In the figure above, the label „Name‟ is used to indicate that the text 
box next to it should be used to enter the Name. 
 
List box 
This control is used to present a list of available options. When the number of display items is 
more than that can be displayed in the list box, a vertical scroll bar is automatically added. The 
user selects one or more items by clicking on the required item in the displayed list. 
 
The advantage of using a list box lies in the user not having to remember all possible options. It 
also ensures that the user doesn‟t enter something that is not valid. Futhermore, a list box allows a 
user to select more than one option too. 
 
Combo box 
A combo box is a combination of a list box and a text box. The list box only allows the user to 
select from the available list by clicking on it. The user is not allowed to key-in a value. 
 
The advantage of a combo box is that the user may also type the value in the text box portion of 
the control. The user can also view the list by clicking on the arrow on the right hand corner of the 
combo box, and selecting one option. In addition, with a combo box it is possible to display only 
the selected item while the rest of the list is hidden. For example, if Stronghold Inc. sells 15 items, 
it will be very inconvenient to display such a long list in the form. 
 
Radio buttons 
The radio buttons, also referred to as „Option buttons‟, are used when the user can select only one 
of multiple options. The radio buttons work as a group. At any point of time, only one of the many 
can be selected. 
 
Check boxes 
The check box component is used when a user can select multiple options from those specified, 
unlike the radio buttons. The user can select as many check boxes as required. 
 
Creating a form: 
 
A form can be created easily, by using „AutoForm Wizard‟. This just prompts the user for the name 
of the table or query whose records are to be displayed in the form. The Wizard then takes the default 
settings for the font, background etc., and creates a form in a columnar, tabular or datasheet format, 
depending on which of these options had been initially selected by the user. 
 
Follow the steps given below to create a „Columnar‟ form: 

Steps: 
1. Click on the Forms tab and click on the New Button 
2. In the box that follows, select‟AutoForm: Columnar‟ (Fig.22, next page) 
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3. Select the „Table‟ as the „Record Source‟, (as shown in the figure above) and click on the 
„OK‟ button. 

4. Save the Form followed by a name 
 

 A form is created as shown below. The source for the records in the form is the „Trg_attend‟ 
table. 
 

 

Figure 23: Creating a ‘Columnar’ form using the 
‘AutoForms’ Wizard 

 

 
Note: in the same way, a form can be created in the „tabular‟ or „datasheet‟ format by using 
the‟AutoForm‟ Wizard. 

 

Creating a Form using the Form Wizard: 
3. Click Forms tab and  select the‟Form Wizard‟ option.you will get the first wizard dialog 

box as shown in fig.-23 (next page). 
4. In the Tables/Queries dropdown list, choose the table or query to get fields from the form 
5. Click a field and then click right-pointing arrow to include the field in the form. You can 

click on the double-arrow to include all the fields to the Form and then press Next. 
 

Choose the table        
or query for Record    Adds fields to the Form 
 Source 

 
6. Select Columnar as the layout for 

the form, and click on the Next  
 
7. Select the Style for the form and 

click on the Next  
 
 
8. Give the Title of the Form and 

Click on the Finish                   
                                     
                     
 
 

                                                  

 
 Click to choose a field                      

            Adds all fields to the Form 
Note that using any of the forms created above, we can navigate through records using the 
Navigation Buttons at the bottom of the form. Records can also be added in the same way. 

F
ig.- 2

5
: S

electin
g
 field

s
 

Fig.-22: Different ways of 
creating a form 

 



Page 27 of 37 

 

 
Entering Data in Forms: 

1. To enter data in a form, click New Record button  
 

2. When you do so, an empty form appears onscreen. Enter data. 
3. To move to the next field, press TAB or Enter Key. 

 
Viewing Records on Forms: 
Use the Toolbar (Fig.26) along the bottom of the Form Window to move from record to record 
and view data. 
 

                          Enter a record no. to go to          Go to the Last Record 
                                                                                                     Enter a New record 

                   
 

           Go to the First Record                             Go to the Next Record 
                               Go to the Previous record 

                                                                                          Fig.-26: Form Toolbar 
Copying Data from one Record to Another 
Steps: 

1. Display the Record that you want to copy 
2. Click on the Vertical bar on the left side of the form (fig.-27, next page). It will select all 

the data in the record. 
3. Click on Copy  

 
4. Click on New Record button 
5. Click the Vertical bar on the left side 

of the blank form  
6. Click Paste 

 
  Click here to 
select a record‟s 
complete data 

 
                     Fig.-27 

 

Creating a Form in Design View 
Steps:  

1. Create a new form by clicking on the New button in the Forms tab. 
2. Select „Design View‟ and „Trg_attend‟ as the name of the table, in the combo box below. 

Click on the OK button. 
3. The „Design View‟ of the form is displayed as shown in the figure below. 
 

 
 

Fig.-28: Design View of the form 
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4. Click on the „Plno‟ field in the field list and drag it to the form. Similarly, drag the other  
fields to the form.   

5. Switch to Form View by clicking the Form View button  
 
 
 
 
        

 
Figure 29: The Form View 

 
In the form above, it may be seen that a lot of the form area is blank.To modify this, as well as the 
background, the font formatting etc.. The steps are given in next page. 
 
 
Steps:  

1. Switch to the Design View. 
2. Right click on the form (marked 1) , as shown below, and select „Form Header/Footer‟ 

from the shortcut. This displays a header and footer section for the form. 
 

 
Figure 30: The Form View 

 
3. Select the „label‟ control (marked 2) and drag it into the „Form Header‟ portion, and enter 

„Training Attended Form‟, as the heading for the form 
4. Right-click on the label that we just created, and select „Properties‟. The „Properties‟ 

window of the particular label is displayed  
5. Scroll down through the All tab in the Properties window. 
6. Change the Font Size to 12, Font weight to Bold. 
7. Click in the Fore Color row and click on the button alongside. Choose some appropriate 

colour in the box that follows. 
8. Close the Properties window and observe the changes in the label. 
9. Select individual text boxes and align them within the form area. 
10.  Switch to Form View 

 
 

Note, that a miniature of the ‘Trg_attend’ table is displayed above, along with the fields in the table. If this 
is not visible, or you have closed it, click on the ‘Field List’ button          in the toolbar. 
 

1 

 
2 
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Adding command buttons to the Form  
(to help us in navigating, deleting and adding records). 
 

1. Switch to the „Design View‟ of the above created form. 
2. Drag the „Footer‟ down to make some space for the command buttons below the text 

boxes. 
3. Select the „Command Button‟ tool in the toolbox(fig.-30) . Click and drag it in the form. 

This Activates the control Wizards button (fig.-31). 
 

 
 

 
  

4. In the „Actions‟ list box, select „Goto First Record‟. Click on the „Next‟ button. 
5. In the second step, we need to specify what is to be displayed on the face of the button. If 

you want a caption to be displayed, enter it into the textbox marked „1‟ in the figure 
below. To display a picture, select the picture from the list (marked „2‟ in the figure). 

 
6. Click on the „Next‟ button. 
7. In the last step, we need to provide a 

meaningful name for the button, which will be 
useful to refer to it in code. 

8. Enter the name as „cmdFirst‟ (without the 
inverted commas), and click on the „Finish‟ 
button. Similarly you can create buttons to 
navigate to the next, previous and last records. 
You can also create buttons to add, save and 
delete records. 

 

 
 

Figure 32 

Since we have created our own buttons to navigate through the records, we don’t need the 
default navigation buttons that appear on all forms. To disable these buttons, change the 
‘Navigation Buttons’ property in the ‘All’ tab of the Properties’ window to’No’. 
 
 
Creating a „Modal‟ Form and setting it as the „Startup‟ Form 
 
In Applications such as Microsoft Word, it is observed that when open a dialog box, the document 
in the background can‟t be accessed unless the dialog box in the foreground is dealt with, usually 
by clicking on the OK or Cancel button. The dialog box in this case, is said to be „modal‟ in 
nature. In a database application, there might be a need for such a form, which requires users input 

Figure 30: Selecting the action to be associated 
with the button 

 

Figure 31: Control Wizard 
 

 1 

 2 
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before proceeding with the rest of the application. Such a form is called Modal form. A „Startup‟ 
form in most applications is an example of such a form. Steps for creating a Modal form is given 
below: 

1. Create a new form in the „Design View‟. Don‟t specify any record source.  
2. Select the label control. Click on the form and drag it. Enter „Welcome to Training 

Management System‟. as the caption for the label. Similarly, create another label with the 
caption „Human Resource Development Centre‟. 

3. Select the „Image‟ control‟ and drag it in the form. In the dialog box that follows, select 
the name of any image file, and click on the „OK‟ button. 

4. Add a command button to the form. Using the „Control Wizard‟, select „Form 
Operations‟ in the „Categories‟ list box, and „Open Form‟ in the „Action‟ list box. 

5. Select the name of some form in the next step. Select some option in the consequent steps. 
6. Add more labels (Rourkela Steel Plant) and then align all the controls. 
7. In the „Form‟ properties, change the „Modal‟ property to „Yes‟. 
8. Save the form as „TMS‟ 
 

This form will now be the form that opens first, when we start up the application. To make it the 
„Startup‟ form, follow the steps given below: 
 

1. Click on Tools -> Startup 
2. In the „Display Form/Page‟ combo box, select the name of the form we just created, that is 

„TMS‟, and click on the‟OK‟ button. 
3. Close the database. 
4. Open the database again. 
5. Notice that the TMS form appears first. 
6. Clicking on the „OK‟ button opens the form specified. 

 
 
 
 Using Autoform Wizard  

1. Create a tabular form for the Employee table and save it as Form_Employee 

 Using Form Wizard Create a form using table Trg_Code and name it as Form_ Code  

 Using Design View 

1. Create a form for Trg_attend  
2. Add Label “Training Attended”  
3. Browse through the Properties and change the label such that text in it should be centre-aligned, 

change the back ground colour, font colour etc. 
4. Attach a proper header to your form 
5. Create buttons to navigate to the next, pervious, first and last records. Name them cmdNext, 

cmdPrev, cmdFirst and cmdLast 
6. Also create buttons to add, save, delete records and Run MS Word and align therse buttons 

neatly 

7. Try adding Record, deleting and saving 
8. Create a Modal Form – Training Management System, design it with SAIL Logo  
9. Make it the Startup Form of the database 

Exercise-V 
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Generating Reports 
 

A Report is a properly presented and explanatory listing of data, printed on a paper. It can 
contain data from: 
 Some fields in a Table 
 All the fields in Table 
 Fields from more than one Table 

 
And a report should have: 
 All the required information 
 Additional information for good presentation value 
 Highlighting of important data 

 
Components of a report: 
 

 
 
 
 Report Headings    :  Contain information such as Name of the company, Department etc..  

 Appears at the Top of the page. 

Column Headings  :  Headings of data provided in the body section of the Report.  
 Should be appropriate for the data and clearly indicating column of 

data 
 Should be formatted so that they can be distinguished as headings.  

Body of the Report:  Data for which the report is created. 
 Located just below the relevant column headings 

Footer Elements    :  Usually include details such as the date, time name of the person 
preparing the report, page number etc. 

 Appears at the bottom of the page 

Report Heading 
Column Heading Column Heading 

Body of the Report 

Footer Elements 

Fig.-33: Components of a Report 
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Creating Report using „Report Wizard‟ 
 
Steps: 
 

1. Double click on the „Create Report by Using Wizard‟ option in the Report Tab or click 

on the New->Report Wizard 

2. Select the „Table or Query (let Trg_attend)‟ as source data 

3. Select the fields to include in the report -> Next 

4. Select „Deptt‟ as Group Header -> Next 

5. Select „Pl_no‟as sorting order -> Next 

6. Select a Layout for your Report  (Tabular) -> Next 

7. Select a Style for your Report ->Finish   

 
Adding Groups to a Report 
 
Reports are much more readable when data is sorted or grouped. For example, in a Employee list 
you can sort list of employees by the department to which they belong. Each department has its 
own header and all employees in same department can be sorted. for adding grouping level, follow 
the steps: 

1. Open the Report in design view 
2. Click on the Sorting/ Grouping button         on the tool bar. It will display the Sorting and 

Grouping Option Box. (fig.-34) 
 

3. Select the field on which to group 
(marked 1) 

4. To add a Group Header, change 
the Group Header field to Yes 
(marked 2) 

5. To change the value that will begin 
a new group when the report is 
run, select Each Value from the 
Group on Field (marked 3) 

6. Select whole Group from Keep 
Together (marked 4) 

7. Save and Run the Report 

 

 
 
Adding Sl. No. to a Report  
 
To add Sl. No. to a report follow the steps: 

1. Insert a Text Box from the Tool Box in Design View. When you insert a Text Box, you 

will get two fields named Text and Unbound.  

2. Separate the two fields. Use the Text field as Label and in Unbound field Type=1(Fig.-35) 

1 

2 

      3 

    4 

Fig.-34:Adding Group Header to  Report 
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3. Right click on the unbound 
field to display Property Box 

4. On Running Sum option 
select Over Group or Overall  
as per Requirement 

5. Save and Run the Report.  

 

 
 
 

 
 
  
    
 

 

1. Create a report that will display the Employee details from the Employee table. The report 

should group the employees together by Deptt-wise and sorted in ascending order. 

Also  display with summery of the report. 

2. Add Label, Header and Footer to your Report 

3. Add Sl. No and change the properties so that the a new sl. no will be started for each group 

4. Create a report that displays the Employee Name, Pl. No. Design, Deptt and Training 

attended  for MS Access Deptt.-wise. 

 
 
 
 
 
 
 

Exercise-VI 
 

Fig.-35:Adding Sl. No to a  Report 
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 Import Data from Another Data Source 
 
Import data is very much like copying it. Data stored in different formats can be imported into one 
or more Access Tables. The source data is not modified in any way and remain intact. 
 
Steps : 

1. Open a database into which you would like to import data and select table tab. 

2. Click on New and from the dialog box select Import Table. 

3. From the import dialog box, select the file name and file type. 

4. Click Import. A message box confirms that the table was imported. 

5. Repeat the above steps to import additional tables, if desired. 

6. Click close. The imported tables will be displayed on the Tables tab of the database 

window. 

Export a Table/Query to a Spread Sheet/Dbase 
 
The same data stored in an Access table/query can be used in a spreadsheet without retyping. This 
is accomplished by exporting. 
 
Steps: 

1. Open a database and select table or query tab. 
2. Select a table or query to export. 
3. Select Save As/Export from the File Menu. 
4. Select To an External File or Database in the save as dialog box and click OK. 
5. Select the folder and file type into which you would like to export the table/query 
6. Click Export. 
 

 To Export a Selection to Microsoft Excel/Word 
 
Steps: 
1. Open a database and select the desired data to be exported. 
2. Select Tools-> Office Link -> Analyze it MS Excel or Publish it With MS Word. 
3. The selected data will be saved in Excel/Word File. 
 

Merge Data with Microsoft Word 
 

Data from an Access Table  (or Query) can be used as the data source for a merge in MS Word. 
 

Steps: 
1. Open a database and select a table or query. 
2. Select Tools->Office Link -> Merge it with MS Word. 
3. Then select Link Your Data to an Existing MS Word Document and click OK. 
4. Select the MS Word Document to which you want to Merge Data and press Open. 
5. Then Insert the Merge fields as you normally do in MS Word Mail Merge Data. 
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Auto Number Access field type that automatically inserts a sequentially numbered value in each record. 
Bound Control A control on a report that displays field data stored in a field in an underlying table. 
Cell A single rectangle of a datasheet or design grid that can contain data or instruction. 
Check Box A control on a form/report that displays a check for a yes/true condition or nothing for a 

no/false condition. 
Clipboard A area of windows memory where any cut or copied information is stored and from which 

stored information is pasted. 
Criteria Instructions to limit records to be displayed in a query, form, or report. 
Data Information stored in tables in a database. 
Datasheet Data from a table or query displayed in columns and rows. 
Design View The mode in which form or report layouts can be modified. 
Export To copy an object or data to a separate file. 
Expression A combination of fields, constants, variables, operands and functions, the result of which 

is a single value. 
Field One item of information on a record of table; a column in datasheet view. 
Filter Criteria applied to a group of records to limit the display or printing of records. 
Footer A section of a form or report that appears at the bottom of a page or a report. 
Grid Data displayed in column and row format, known as a datasheet. Also, a design aid in 

design view. 
Header A section of a form or report that appears at the top of a page or a report. 
Index A file in which field values are sorted in a sorted order. Index speed up searches, queries 

and filters. 
Label An unbound control that displays text on a form or report. 
Operator A keyword or a symbol (e.g. And , Not, +, -, *) that indicates the action to be taken 

usually between two values, strings or variables. 
Preview To view on the screen the printed version of a table, query, form or report. 
Primary Key A Field (or Combination of fields that uniquely identifies a record. 
QBE Grid  The bottom part of a query window. 
Query A stored set of instructions regarding displaying or changing data in a table. 
Record One row of data in a table. 

Relationship A link between two fields in one or more tables of a database. 
Sort To arrange records of a table or query in either ascending or descending 

order based on the field values. 
Template A stored form or report layout that can be used as the basis for new forms 

and reports. 
Text Box A control on a form or report that displays text and can accept text enties. 
Toolbox A group of buttons that aids in database activities and provides shortcuts to 

selections. 
Toolbar A varying group of buttons that aids in database activities and provides 

shortcuts to menu selections. 
Variable A placeholder in an expression that stores changing data. 
Wizard A Microsoft tool that automates many database design tasks. 
Zoom Box A window that gives a larger view of information in a cell or field. 

 
                                                                        
                                                                                  

GLOSSARY 
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1. Never insert anything metallic into the 
computer openings. Doing so may create the 
danger of electric shock. 

2. Locate your computer near an easily 
accessible AC outlet. 

3. Do not open the computer case on your own. 
Only a qualified technician should open the 
computer’s case. 

4. If your computer does not operate normally 
– in particular, if there are any unusual 
sound or smells coming from it – unplug it 
immediately and contact an authorised 
dealer or service centre. 

5. Never use your computer if the power chord 
has been damaged. Do not allow anything to 
rest on the power chord, and keep the cord 
away from areas where people can trip over 
it.??? 

6. High temperatures can cause problems. 
Don’t use your computer in direct sunlight, 
and keep it away from heaters, stoves, 
fireplaces and other sources of heat. 

7. Be sure to hold the plug, not the chord, when 
disconnecting the computer from an 
electrical socket. 

8. Unplug the computer when it is going to be 
left unused for an extended period of time 

9. Do not expose the monitor to rain or use it 
close to water outlets. . If the monitor 
accidentally gets wet, unplug it and contact 
an authorised technician immediately. You 
can clean the monitor with a damp cloth 
when necessary, but be sure to unplug the 
monitor first. 

10. Unplug your computer from the AC outlet 
before any service. 

11. Openings in the monitor cabinet are provided 
for ventilation. To prevent overheating, these 
openings should not be blocked or covered. 
Be sure to provide adequate ventilation if the 
monitor is placed in an enclosed space. 

12. .Put your computer in a location with low 
humidity and a minimum of dust. 

SSSaaafffeeetttyyy   IIInnnssstttrrruuuccctttiiiooonnnsss   
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Safety and Comfort Guidelines at Computer Workstation 
 

Posture, lighting, furniture, work organization and other work conditions and habits may affect the way you feel and 
how well you work. By adjusting your work environment and personal practices, you may be able to minimize fatigue 
and discomfort, and reduce the risk of resulting strains that some scientists believe can lead to injury.  
                                                                      

                                                                                                                                              
 
 

RIGHT WRONG 
Feet, Knees and Legs 

 Put your feet on the floor, flat on the floor or use a footrests 
and  

 Be sure you have sufficient space under your work surface 
 Stretch your legs and vary your leg posture throughout the 

day 
 Take a break every now and again, some recommended 

atleast five to ten minutes per hour when sitting in front of 
the computer. Because all these postures prevent circulation 
of blood in the body. Just make some rounds to switch off 
the posture and the get the blood flowing again 

 Do not curl and twist 

Back 
 Distribute your weight evenly and use the entire seat and 

back rest to support your body 
 Don’t bend forward 

Forearms, wrists and Hands 
 Hold a straight, natural wrist position while typing 
 Use a computer desk with a pull-out self for keyboard 

 Don’t rest your palms on a 
 work surface while typing 
 Don’t rest your wrists on sharp 

edge 
Shoulders 

 Adjust your chair or key board height so that your shoulders 
are relaxed and your elbows hang properly at your sides 
and it should be at the height of your keyboards home row 
(row that includes the letter G and H) 

 Don’t support the arms up on 
the edge of the desk 

Eyes 
 Give your eyes frequent breaks 
 Periodically look away from the monitor and focus at a 

distant point 
 While looking at your computer and also while resting your 

eyes, remember to blink 

 Don’t use bright colour 
schemes  

Monitor  
 The monitor should be at eye level; one should not have to 

crane his neck upwards to see it 
 If you look at the monitor 

more than you look at paper 
documents, avoid placing your 
monitor to the side 

Keyboard and pointing devices 
 Position the key board directly in front of you to avoid 

twisting your neck  
 Positing your pointing device immediately to the right or left 

of your keyboard 

 Don’t position your keyboard 
and pointing devices at 
different levels and distance 

 

Computers are indeed a pain, in more ways than one. But with a little thought and 
experimentation, we can reduce that pain, and may be even eliminate altogether. 
 


